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Phoenix User's Guide
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Introduction

This section briefly describes how to install Phoenix and includes some basic information
on how to use the program. More detailed information can be found in the Phoenix Help
files. Each feature in Phoenix has its own Help file, which can be activated whil running
Phoenix. To activate a Help file while Phoenix is running, press the F1 key or the specific
feature's Help button.

General Setup Procedure

Initial installation of Phoenix requires the complete Phoenix installation package. This
package, currently around 30 Megabytes in size, is provided on a CD-ROM disk. Because
of this large size, it is not recommended to download the file nor is it practical to provide
it on 3.5-inch floppy disks.

Install Phoenix by following the steps outlined on the material that comes with the disk.
It should be noted that installation of a Nokia dongle on the computer being loaded is
REQUIRED prior to beginning the installation of the software.

The software is packaged into an Installshield executable bundle. When the user double-
clicks on this file, the installation program provides on-screen instructions on how to
proceed. Standard installation, provided by selecting all default choices, is highly recom-
mended. You may do a custom installation and place Phoenix into a special location on
your hard drive, but this is only recommended for experienced users.

It is necessary to reboot the computer after installing the software. The program will not
be usable until a reboot is performed. After reboot, the Phoenix icon is displayed on the
computer desktop. Double-clicking on this icon launches the program.

i3
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Hardware Requirements for using Phoenix

Minimum Hardware Requirements

Processor 233 MHz

RAM 64 MB

Disk Space Needed 50-100 MB

Supported Operating Systems Notes

Windows 95 Limited, no USB support
Windows 98

Windows NT 4.0 no USB support
Windows 2000 Professional version

Installing Phoenix
Before installing the software, verify:

¢ The dongle is attached to the parallel port for PKD version dongles, or an FLS-4 version
dongle is attached on either the parallel port or the USB port (if the computer supports
USB).

e Ensure that if the computer supports administrator rights (typically on Windows NT
and Windows 2000 installations) that access is enabled for the user performing the
Phoenix installation.

e |f a previous version of Phoenix has been installed, it may be necessary to first properly
remove that program prior to installing the new version. If installation is performed, be

sure to reboot the computer prior to continuing. See the section Uninstalling Phoenix
for instructions on how to uninstall.

Installation Directions
¢ Insert the CD-ROM disk into the computer drive

® Access the drive and double-click on the Phoenix software package found on the CD.

® Follow the on-screen prompts to conclusion.
Note that rebooting the computer may be necessary when completed.

Software Support Bundles:

The Phoenix installation is auto-executable. You must obtain Software Support Bundles
to load software upgrade files to customer-specific phone models.
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These bundles are created by PAMS and made available by AMS on the Partners Web
Page http:/[americas.partners.nokia.com. This web page is password-controlled; if you
have not registered as a user, contact Nokia Central Service in Melbourne, Florida.

Similar to the Phoenix installation, these Software Support Bundles are InstallShield exe-
cutable packages. Just double-click on the package and it will auto-install.

No rebooting of the computer is required.
Starting a Phoenix Session

Concepts

When referring to Phoenix, Product is the cellular phone attached to the computer.
More specifically, it is the particular type of phone.

Connection is the type of cable used to attach the phone and the port on the computer
where it is attached. Refer to Service Tools chapter for additional information.

The first time Phoenix is used, certain connection configurations must be made. Subse-
quent uses will rely on these selections and they will not need to be made again.

Initial Session with Phoenix

It is necessary to create the connection the first time Phoenix is used. Follow these sim-
ple steps:
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Select Manage Connections... from the “File" drop-down menu.

Dgphoon

File Edit Product Flashing Tool: ‘Window Help

Hew Prafile
Open Profile....
Save Profile
Save Profile As...
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Scan Product Ctil-R
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Next click the Add... button to create a new connection.

: Manage Connections |

Pricrity list: Apply
FEBUS COMZ

FEUS COR1 Revert |
RELS COM1 —

MO COMMECTION

Bemove...

Help

When the Select Mode dialog box appears, you may then select either Wizard, which will
auto-detect your connection configuration, or Manual, which allows you to manually
select options to create the connection.
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Once a connection is defined, make sure that the one to be used is moved to the top of
the list (use the up down arrows on the Manage Connections dialog box. Then click on
the Apply button. Close the window when finished.

You can now proceed with the normal initiation of a session by selecting a product or
scanning for a product.

Scanning for a Product

Many features of this program are product-specific. Therefore it is necessary to config-
ure Phoenix for the product on which you will be working at the beginning of the ses-
sion.

Scan Product - Choose Scan Product from the drop-down menu list and Phoenix will
automatically scan for product and select the necessary configurations. The status bar
at the bottom will indicate if the product was found and its type.

Using Components

When working with Phoenix, tasks are generally managed by specific software compo-
nents. From the menu, select the desired component or task to be performed.

"Opening a component” is defined as opening a tool window within Phoenix. When this
window is opened, Phoenix also opens a toolbar for it and adds component-specific
menu items in the Window menu.

Using Profiles

Phoenix's Profile feature allows product, connection and currently open components to
be stored into permanent storage by creating a profile file with a name of your choice
followed by an .nmp file extension for later retrieval.

Saved profiles makes it easy to configure Phoenix into a desired configuration with
favorite windows already opened and ready to go.
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Opening and saving profiles is done via menu commands found in the File drop-down
menu: Open Profile and Save Profile.

Profiles are stored into a disk file with user-defined names. As a result, there can be
multiple profiles for different repeated tasks or user preferences.

Uninstalling Phoenix

As mentioned in the Installing Phoenix section, it may be necessary or desirable to
remove Phoenix. Care must be taken to follow this procedure. Failure to remove the
program properly will cause misconfiguration of the computer's registry.

Uninstalling Phoenix version:

® Access the computer's “Control Panel” section, selectable from the Start button or the
"My Computer” desktop icon

e Select the "Add/Remove Programs” icon

e Select the Phoenix version to be removed, and click the Add/Remove button
® Click on the OK button to begin the process of removal

® Follow the on-screen instructions

Be sure to reboot the computer when finished.
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Diego User's Guide

Diego
Pleaze wait while the zotbware loads...

Introduction

This section briefly describes how to install Diego and includes some basic information
on how to use the program. More detailed information can be found in the Diego Help
files. Each feature in Diego has its own Help file, which can be activated while running
Diego. To activate a Help file while Diego is running, press the F1 key or the specific fea-
ture's Help button.

Diego is designed to be used by point of sales locations. Ease of use and minimal opera-
tor decision-making were key factors in the design. Additionally, this Diego version is
compatible with current-generation phones (DCT3 versions such as 5185i, 5170i, 5180i,
6185i, and 3285) and the new generation phones currently being introduced (DCT4 ver-
sions such as the new 6385).

General Setup Procedure

Initial installation of Diego requires the complete Diego installation package. This pack-
age, currently around 18 megabytes in size, is provided on a CD-ROM disk. Because of
this large size, it is not recommended to download the file nor is it practical to provide it
on 3.5-inch floppy disks.

Install Diego by following the steps as outlined on the material that comes with the disk.
It should be noted that installation of a Nokia dongle on the computer being loaded is
REQUIRED prior to beginning the installation of the software.

The software is packaged into an InstallShield executable bundle. When the user dou-
ble-clicks on this file, the installation program provides on-screen instructions on how to
proceed. Standard installation, provided by selecting all default choices, is highly recom-
mended. You may do a custom installation and place Diego into a special location on
your hard drive; however, this is only recommended for experienced users.

It is necessary to reboot the computer after installing the software. The program is not

usable until a reboot is performed. After reboot, the Diego icon is included on the com-
puter desktop. Double-clicking on this icon launches the program.
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Hardware Requirements for using Diego

Minimum Hardware requirements

Processor 233 MHz

RAM 64 MB

Disk space needed 50 - 100 MB
Supported Operating systems Notes

Windows 95 limited, no USB support
Windows 98

Windows NT 4.0 no USB support
Windows 2000 Professional version

Installing Diego

Before installing the software, verify:

e An FLS-4 version dongle is attached to either the parallel port or the USB port (if the
computer supports USB). An FLS-2D may be used; however, the FLS-2D does not support
the new generation DCT-4 version phones.

e Ensure that if the computer supports administrator rights (typically on Windows NT
and Windows 2000 installations) that access is enabled for the user performing the
installation.

e If a previous version of Diego has been installed, it may be necessary to first properly
remove that program prior to installing the new version. If installation is performed, be
sure to reboot the computer prior to continuing. See Uninstalling Diego for instructions

on how to uninstall.

Installing:
® |nsert the CD-ROM disk into the computer drive.

® Access the drive and double-click on the Diego software package found on the CD.

® Follow the on-screen prompts to conclusion.
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Note that rebooting the computer will be necessary when completed.

Software Support Bundles:

The Diego installation is auto-executable. You must obtain Software Support Bundles to
load software upgrade files to customer-specific models.

These bundles are created by PAMS and made available by AMS on the Partners Web
Page http://americas.partners.nokia.com . This web page is password-controlled; if you
have not registered as a user, contact Nokia Central Service in Melbourne, Florida.

Similar to the Diego installation, these packages are executable packages. Just double-
click on the package, and it will auto-install.

No re-booting of the computer is required.
Starting a Diego Session

Concepts

When referring to Diego, Productis the cellular phone attached to the computer. More
specifically, it is the particular type of phone.

Connection is the type of cable used to attach the phone and the port on the computer
where it is attached. Refer to Service Tools chapter for more information.

The first time Diego is used, certain connection configurations must be made. Subse-
quent uses will rely on these selections and they will not need to be made again.

Initial Session with Diego and FLS-4S Dongle

You must configure the Virtual Port Connection in Diego the first time Diego is launched.
The FLS-4 dongle uses virtual port, which eliminates the need to use the serial port (as
the FLS-2D does). During the installation of the FLS-4 drivers (included in the Diego
installation package), a virtual COM port is set to the next available COM port number.
This port selection must be put into the Diego configuration.

Follow these simple steps:
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Select "My Computer” desktop icon and click on the “FLS Virtual Port" icon.
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Make note of the Virtual Port Assignment (COM 2 in this example).

Next select "Add..." to create a new connection.
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Note: COM port settings can only be entered or changed if the auto-connection feature of Diego is
disabled (as indicated in the grey Status box). To disable the auto-connect feature, click on this icon in
the toolbar.

Select the Virtual COM port setting . Then press the Apply button.
Seltings

General  Senal Paort |

Select an available paort: IM "I

Fing phone every I-I I j zeconds

k. I Cancel Sl Help

You can now proceed with the normal initiation of a session.

Scanning for a Product

Many features of this program are product-specific. Therefore, it is necessary to config-
ure Diego at the beginning of a session for the product on which you will be working.

Scanning of the product can be done manually or automatically. The default setting is

automatic. This setting can be changed to manual in the "settings” - “general” box. In
automatic mode, Diego will automatically scan for a product at a periodic rate. The scan
rate is defaulted to every 5 seconds, but it can be changed to a different frequency in the
Setup menu.

To manually scan for a product, click on the “Settings" icon as noted above.

Using Components

When working with Diego, tasks are generally managed by specific software compo-
nents. From the icons displayed on the left side of the screen, select the desired compo-
nent or task to be performed.

"Opening a component” is defined as opening a tool window within Diego. When this

window is opened, Diego also opens a task box for it, which includes component-spe-
cific menu items.

Uninstalling Diego
As mentioned in the Installing Diego section, it may be necessary or desirable to remove
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Diego. Care must be taken to follow this procedure. Failure to remove the program
properly will cause misconfiguration of the computer's registry.

Uninstalling Diego version:

Page 16

® Go to the computer's "Control Panel”, selectable from the Start button or the "My
Computer" desktop icon.

e Select "Add/Remove Programs" icon.
e Select the Diego version to be removed, and click the Add/Remove button.
® Click on the OK button to begin the process of removal.

® Follow the on-screen instructions.

Be sure to reboot the computer when finished.
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